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Welcome To TalkMaster

Welcome

Welcome to TalkMaster™ LE! TalkMaster LE and ii3™ Ethernet Intercoms are products of the
Digital Acoustics Corporation.

If you are upgrading from an earlier version of TalkMaster™, please review the Release Notes.
To setup and configure your ii3 series intercoms, please review Configure Intercoms.
If you would like help on using TalkMaster™, please review TalkMaster Overview.

TalkMaster™ LE

Release Notes

TalkMaster™ Version 1.9 Released October, 2006
TalkMaster™ version 1.9 contains the following enhancements and corrections:

¢ Microphone audio is optionally sent to the Intercom using uLaw to improve the audio quality
o TalkMaster will now talk over an intercom if the Intercom’s PTT button is being pressed *

o Added support for the Intercom Call Button feature. Use of this feature changes the PTT
button to a Call-only button and prevents audio from being recorded in the Calls Waiting
Queue *

¢ Updated the Intercom Configuration Tool to include new Intercom options, GP104 settings
and Server Intercom settings

o Corrected the automatic response "Your call is being connected". Inconsistent operation if
TalkMaster had been active for over 24 hours

¢ Increased the amount of time TalkMaster waits for TCP/IP packets before ending an active
conversation to account for switching between wireless access points

o Corrected TalkMaster install to always install TABCTL32.ocx

* Use of this feature requires current Intercom Firmware. Please refer to our website for
information on the current Firmware.

TalkMaster™ Version 1.8 Released November, 2005
TalkMaster™ version 1.8 contains the following enhancements and corrections:

All Setup functions have been moved to the password protected Admin menu

New tabbed views on main screen allow display of all Intercoms or all Paging Groups and
selected Intercoms.

New function to setup software based Paging Groups for paging operations

New option to create a Managed Intercom list to continuously detect and display
disconnected Intercoms.

Multiple consoles can simultaneously forward their Intercoms to a single console

New color coded buttons used when TalkMaster is paging multiple intercoms
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e Clicking the Grp column header automatically clears checkmark from all rows

e The Settings and Advanced tabs of the Preferences dialog have been renamed to the
Volume and Legacy tabs respectively

o Preferences and settings are now stored at the PC level instead of the Windows User level

TalkMaster™ Version 1.7 Released June, 2005
TalkMaster™ version 1.7 contains the following enhancements and corrections:

¢ New Paging Messages dialog with up to eighteen predefined messages

o New Password protected Paging Setup dialog

¢ Intercom Configuration Tool now sorts by Location Name/ICOM ID for easier setup
e GPIO 4 Mode supports new options for Relay controls*

o Improved speed and reliability of Console Forward / Retrieve operations *

e When "Hide when minimized " preference is set, clicking the X’ in the upper right hand
corner of the screen causes TalkMaster to minimize to the system tray instead of closing

¢ Intercom Configuration Tool prevents Intercom IP address from ending with 255 or 0
¢ Accessing the Play Audio Archive dialog requires the administrator password

o The Preference "Talk button enabled by mouse click and hold" has been renamed to "Hold
down Talk button while speaking (PTT)"

e Corrected "Intercom configuration changes fail" when Windows Regional Options are not set
to English

e Corrected "UDP Audio problems" when Windows Regional Options are set to Japanese
e Corrected "Multimedia Card Selection" when multiple cards are present in the PC

* Use of this feature requires current Intercom Firmware. Please refer to our website for
information on the current Firmware.

TalkMaster™ Version 1.6 Released January, 2005
TalkMaster™ version 1.6 contains the following enhancements:

e Call Announcement mode with audio and visual notification of incoming calls

o Automatic removal of entries from the Calls Waiting queue when a call is completed
¢ The Calls Waiting Audio Player is automatically closed at the end of a call

o Ability to select a multimedia card used for the Speaker and Microphone operation

TalkMaster version 1.6 contains the following bug fixes:

Applying Intercom configuration changes fails in non-U.S. localizations

Talk VU meter does not work

Intercom Startup Audio is not always played

Spurious error messages occur during TalkMaster Startup

"Details" column size under Calls Waiting is too narrow

In Automatic mode, TalkMaster’s Listen button can be turned off by pressing the Intercom’s
Call button

Multiple Intercoms behind a NAT Firewall do not function properly in TalkMaster
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TalkMaster™ Version 1.5.215 Released July, 2004
TalkMaster™ version 1.5.215 contains the following enhancements:

o Simplified screen

e Password protected Intercom search and configure

¢ Console forwarding and retrieval

e Enhanced Audio Archive functions

e The Door Open function appears on the main screen
o Keyboard control of the Talk and Listen buttons

New firmware is available for the ii3 IP Intercoms. Units must be flashed with new firmware to
accommodate the following features. Please refer to Configure Intercoms for details:

¢ Location names flashed into the Intercom
¢ Audio sent to multiple intercoms is sent as a single a UDP broadcast
¢ Console forwarding and retrieval

o Specify alternative IP addresses for intercom forwarding in the event of TalkMaster console
failure

o Specify duration of time for activation of door/open relay within the ii3 IP Intercom

System Requirements
To utilize all of the features of TalkMaster™, you need the following:
Windows 98SE, Windows 2000, or Windows XP
Pentium 11l 750mHz or faster
128 MB RAM (256 MB suggested)
50 MB Available Disk Space
Windows supported Sound Card with microphone and speakers
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TalkMaster Overview

TalkMaster™ is a software program designed to work with Digital Acoustics’ ii3 IP Intercoms.

TalkMaster has two main functions. First, TalkMaster must be used to configure the IP
address information and related features for your ii3 intercoms. TalkMaster searches for any
Intercoms on your network and allows you to specify the IP address settings for each one.

Location Name | Icom ID | IP Address | Details -~ Sflecl:tfd l:te;fmg' Settmgr ~

W 0310A1 0.0.00 No IP addr el e

ﬁEmergenc; CallBox... 030C3E 192.168.254.1... Client [¥] Aszsign IP automatically with DHCP

$Emergenc;.-'CaIIB-:u:... 030C0D 182168.2541... Client

P s e : |F'.-’-‘«ddress| |

L Entry-East 108709 1921682541, Client DHCF

i3 Entry-West 115939 192.168.2541.. Client DHCF Subinet Mask | |

i Fire Exit#1 105560 1921682541, Client DHCF Gateway | |

F ™ Fire Exit #2 030F51 1921682541 Client DHCH DN | |

e = = =

g0 Foyer-East 102774 19216825341, Client DHCF

G Fover-West 102828 192168.2541. Client DHCF il :

i Gate #1 030027  192.168.254.1.. Client Location Name [Fire Exit #2 |

il Gate #2 030C08 192168.2541.. Client

i Loading Dock #1 030C15 192168.254.1.. Client v [ Assign this PC address as client's server

Tl nadina Nl #0 a a2 1E0 9E Clinm

5 EEeceaa e | 5B Server IP [ 192.168.25455 | [ 3000 |

This PCis: MPCOO3 [ List shen offine

IP |F'|:|rt| 3000 @ Enit | Cancel| Apply |
Search

Secondly, TalkMaster allows multiple intercoms to connect to the software via TCP/IP so they
can be monitored by the TalkMaster console operator. The audio from an intercom can be
heard on the PC’s speakers and the PC’s microphone is used to send audio to an intercom.
Calls can be initiated from any intercom to TalkMaster or from TalkMaster to any intercom.

The TalkMaster feature set includes the ability to:

Queue and answer Incoming Calls

e Make Outgoing Calls

e Listen in

e Page Groups of Intercoms via microphone or pre-recorded wav files

e Activate an Intercom’s on board relay to interface with door / gate controls
e Record incoming and outgoing audio

¢ Playback recorded audio

e Temporarily forward Intercoms to another TalkMaster console

¢ Send automatic pre-recorded wav files to Intercoms when the operator is busy or away
¢ Remotely control Intercom volume settings

e Report Online and Offline Intercom status
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# TalkMaster LE
File View Tools Console Admin Help

TalkMaster™ LE

Intercom Yiew T
Grp Lacation Status Address Door/Gate Mates
@ [ | Indoor Speakers
@ [ | Outdoor Speakers
@ | [ |Back Door Intercam Connected 192.168.254.111 | Open
@ | [ | Fort Door Intercom Connected 192.168.254.106 | _Open
Calls Waiting Details R e e skt ane
[ Unattended & Selected
) ) Q) Group
Audio Archive O Al Active
[~ Capture
Flay File
Listen mode

System Events Chime

ready , B intercoms online, Mo calls waiting

Talk

B

192.168.254.112 Speaker on Mic aff

TalkMaster can listen for incoming calls in one of three "modes":

Call Announcement with audible and visual alerts

In this mode, pressing the Intercom button notifies the TalkMaster operator by an audible
and/or visual alert. The TalkMaster operator responds and controls the microphone at that
intercom to enable user hands-free operation. To set up Call Announcement mode, check the
box next to Activate Call Announcement in the menu Admin - Preferences - Options tab

Automatic mode

In this mode, when an intercom user presses the button, their voice is used to notify the
TalkMaster operator of the incoming call. The TalkMaster operator can respond and control the
microphone to enable hands-free operation. To set up Automatic mode, select the Automatic
option under Listen Mode on the main screen.

Manual mode

In Manual mode, when an intercom user presses the button, their voice is used to notify the
TalkMaster operator of the incoming call. The TalkMaster operator can respond and optionally
allow the user to control the PTT button them selves. To set up Manual mode, select the
Manual option under Listen Mode on the main screen.

TalkMaster Main Screen

Before you can use your Digital Acoustics ii3 IP Intercoms, they must be configured with IP
address information. Please see Configure Intercoms.
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The following sections describe the areas of the TalkMaster™ main screen.

# TalkMaster LE

File View

Tools Console Admin Help

= (0

TalkMaster™ LE

Intercom View | Cislom View!
Gip | Location Shakiss | Address Door/Gate MNates
_ﬂ O | Indoor Spaakers
@ | [0 Outdoor Speakers
@ | [  Back Do Intercom | Connected 192.168.254.111 E_nﬁﬂ_]j
@ | O | Font Door Intescom Connected | 152.168.254.106 | [COBSRN
— i : toReme ) Tk o )
: Detals Ti e/ ol
ah'-ug o [ Unsttended ® Selected
= O Go
o Audio &rchive—r. | ) Al.ﬁfﬁve
L2 4 [ Capue| 6 )
< e Flay File
Listen mode ——.
System Events- 2 Automafic 71 ) Chime
tesdy , B intetcams online. Mo calls waking O Sl
| Talk
ety : ! i
R ety 4 : =
192168.254112 Speskeron Mic aff

1 Tool Bar

Intercom View / Custom View tabs

2

3 Calls Waiting Queue

4 Auto Response setting
5 Talk Mode setting

6 Audio Archive setting

7 Listen Mode setting

8 System Events window

Tool Bar

for details.

Intercoms for details.

Forward Intercoms to an alternate TalkMaster Console. Please see Forward Intercoms

Retrieve Intercoms from an alternate TalkMaster Console. Please see Retrieve
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The Answer Later button is displayed when the Activate Call
Announcement option in menu Admin - Preferences - Options has been checked and a call
is incoming.

¢ Activating the Talk or Listen buttons answers the call and removes the Answer Later button
from the screen

¢ Pressing this button sends a message (i.e. "please hold") to the intercom and disables the
Audible and Visual alerts, allowing the TalkMaster operator time to complete another task
before answering the incoming call

Intercom View / Custom View tab

The Intercom View tab shows you all Intercoms that have connected to TalkMaster™. The
Custom View shows all Paging Groups that have been defined as well as any Intercoms that
are not defined in a Paging Group. Both views have the same columns and TalkMaster
operates the same way on either view. You will normally work out of one or the other view
depending on your environment.

TalkMaster can be configured to hide the Intercom View or the Custom View. This option is
available through menu Admin - Preferences.

Intercom View - is used when you require 2-way communication with your Intercoms and
have limited or non-static paging group requirements.

intercom View: | CustomView |
Grp Location £ Status Address DoorGate Motes

@ | [ |Back Door Intercom Connected 192168.254.111 ||_Open

@ | [ |Font Door Intercom Connected 192168.254.105 ||_Open

@ ] | Lunch Room Overhead Speaker | Connected 192.168.254.163

@ [ | Office Overhead Speaker Connected 192.168.254.164

@ (1 | Parking Lot - E ast Speaker Connected 192.168.254.162

@ (1 | Parking Lot - wiest Speaker Connected 192.168.254.113

¢ The first column indicates Intercom’s connection status. A Green ICON means Online, a
Red ICON means Offline, an Orange ICON means at least one Intercom in a paging group is
offline.

e Grp - Click the box to tag Intercoms with an "X" to create an ad hoc paging group.
Intercoms in an ad hoc paging group are simultaneously sent audio when Talk Mode is set
to Group or All Active. To clear all Grp checkmarks, click the Grp column heading

¢ Location - Identifies the Intercom by Name

o Status - Displays the Intercoms connection status

o Address - Displays the Intercoms IP address

¢ Door/Gate - Displays the |_Dﬂ|| button if the Intercom has a Door Relay option

configured. Clicking the button will turn on the Door Relay for the amount of time that has
been configured in the Intercom.

¢ Notes - Displays information about intercom communications

Single click anywhere on a row except the Grp column to select (highlight with a blue
background) an Intercom for Talk / Listen operations. Only one Intercom can be selected at a
time. Clicking the selected Intercom will de-select it.

Right clicking on an Intercom displays the following Intercom Options context menu
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Send announcement to selected units
Activity and Connection Details »

Reset connection

Intercom ID# 030DA4

05 wversion: v1.9.6.80.¥-90.0-2.0-3.68.21
Do NOT list when OffLine

¢ Send announcement to selected unit - Click to send the wave file defined in menu Admin
- Preferences - Startup Audio to the Intercom

o Activity and Connection Details - Click to display the duration of the Intercoms
connection, the time it connected, the last time it received audio, the last time audio was sent
to it, and the IP address and Port it used to connect to TalkMaster

¢ Reset Connection - Click to close the socket the Intercom is connected to and force it to
reconnect to TalkMaster

¢ Intercom ID# - Shows the ICOM ID (last 6 digits of the MAC address)

e OS Version: - Shows the ICOM version, the Intercom option bits, the Intercom model, and
the NIC Version

¢ List when Offline/Do NOT list when Offline - Click to toggle this feature. The List when
Offline feature forces TalkMaster to remember this intercom and to report on it whether it is
connected or not. The List when Offline/Do NOT list when Offline option only appears
when TalkMaster’s Admin menu has been enabled. Refer to Managed Intercoms for more
information

Custom View - is used when you require static paging groups as well as 2-way Intercom
communication. The Paging Groups are listed first and do not list any information in the
Status, Address, or Door/Gate columns. Any Intercoms that have connected to TalkMaster
and have not been defined in a Paging group will be listed next. You can also configure an
Intercom to appear in the list even if it is defined in a paging group by checking Display in
Custom View Tab of the Advanced Configuration Settings of the Intercom Configuration Tool.

| ntercom Wiew T Custum‘d’lew]

Grip Location Status Address Door/G ate Hotes
@ | [ |Indoor Speakers
@ | O | Outdoor 5peakers
@ | [ |Back Door Intercom Connected 1592.162.254.111 [ Open_|
@ | [ |Font Door Intercom Connected 192.168.254.106 || Open_ |

Column definitions are the same as previously listed in this topic.

Single click on a Paging Group row to check the Grp column. Rows marked with an X in the
Grp column are available for Page, Chime or Play File operations when Talk Mode is set to
Group. Paging Groups cannot be selected (highlighted with a blue background) for Talk /
Listen operations.

Right clicking on a Paging Group displays the following Paging Group context menu:
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Office Overhead Speaker is OnLine
Lunch Room Overhead Speaker is OnLine

The connection status of each Intercom in the group is listed.

Calls Waiting
This list shows calls that are waiting to be answered.
Callz Wailing | Detais [ Time
Front Dioor message in at 0757 Ak o3

o If you single click on the entry, that intercom is selected in the Intercom View / Custom
View allowing you to communicate with it

¢ If you double-click on it, the Audio Player pops up so you can play back the original call

Audio Player

The Audio Message Player is automatically started by double-clicking on messages in the
Calls Waiting list. It allows messages that have arrived while communicating with another
intercom to be played back.

Audio message player - i3 [X]
Mezzages from 071:24 P, Jun 18
Intercom: EDW - Client

L

¥l v/ m o0:00:03

v Delete played files on exit

¢ Once you play the audio clip, the "Delete played files on exit is automatically checked and
clicking the X in the right hand corner closes the Audio Player and deletes the clip

o If you choose to leave the Audio Player open, you can delete a call by right clicking on it and
selecting the Delete option

o If Call Announcement is activated, the audio clip is automatically deleted and the Audio
Player closed when the call is completed

Auto Response

The Auto Response function allows you to temporarily suspend the console’s operation. This
function can also be activated by using the menu Console - Unattended Console.

Auto Rezponze
[ Unattended

Once you check the Unattended box, a dialog pops up reminding you that this mode has been
set.

10
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Console Currently Unattended

IInattended Mode iz Enabled

Prezs "Cancel" to return Conzale to normal
operation status.

Any intercom that tries to contact the console is sent a message indicating that no one is
available to take their call. Please see Unattended Console for more information.

Clicking the Cancel button returns the console to normal operation.

Listen Mode

The Listen Mode determines if the Listen button is automatically turned on when the Talk
button is turned off.

If Call Announcement is enabled in menu Admin - Preferences - Options, this option is set
to Automatic and cannot be changed.

Lizten mode
(=) Automatic
{2 Manual

When set to Automatic, the Listen button is automatically turned on when the Talk button is
turned off. This allows the intercom user to operate in a "hands free" mode.

When set to Manual, the Listen button must be activated by the TalkMaster™ operator or by
pressing the PTT button on the intercom.

This setting is saved between TalkMaster sessions.

Example of using Listen mode Automatic

Please note that the following example uses the option of holding the Space Bar to activate
the Talk button. Please see menu Admin-Preferences-options tab for an alternate method of
controlling the Talk button

¢ Intercom user presses and holds the PTT button on one of the Intercoms and begins
speaking.

e The Intercom is automatically selected in TalkMaster and the audio is played through the PC
speakers.

e The Intercom user releases the PTT button when done speaking

o The TalkMaster operator responds by holding down the Space Bar on the keyboard and
speaking into the microphone.

e When the TalkMaster operator releases the Space Bar, the Talk button is turned off and the
Listen button is turned on. This action allows the Intercom user to operate "Hands Free"

e Each time the TalkMaster operator holds down the Space Bar, the Talk button is activated.
When the Space Bar is released, the Talk button is turned off and the Listen button is
engaged.

¢ To end the conversation with an Intercom, the TalkMaster operator presses the Escape key
on the keyboard while the Listen button is active.

11
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An important benefit of using Automatic mode is that other intercoms are precluded from
interrupting your "conversation"” because the Talk or Listen button is always active.
TalkMaster will not interrupt a call if there is already one in progress. Any other intercom that
tries to contact TalkMaster will be placed in the Calls Waiting list.

Example of using Listen mode Manual:

Please note that the following example uses the option of clicking and holding the Space Bar
to activate the Talk button. Please see menu Admin - Preferences - Options for an alternate
method of controlling the Talk button

¢ Intercom user presses and holds the PTT button on one of the Intercoms and begins
speaking.

e The Intercom is selected in TalkMaster™ and the audio is through the PC speakers.
e The Intercom user releases the PTT button when done speaking

o The TalkMaster operator responds by holding down the Space Bar on the keyboard and
speaking into the microphone..

e When the TalkMaster operator releases the Space Bar, the Talk button turns off. The
TalkMaster operator can then click the Listen button or allow the Intercom user to respond
by using the PTT button.

¢ To end the conversation with an Intercom, the TalkMaster operator presses the Escape key
on the keyboard while the Listen button is active.

In Manual mode, it is possible for another intercom to interrupt your conversation by pressing
the PTT button when neither the Talk nor Listen button is active.

Listen button

The Listen button can be activated by the TalkMaster operator or by the PTT button on an
Intercom. You may only listen to a single intercom at one time.

In TalkMaster, with Listen Mode set to Automatic, the Listen button can be toggled by:
¢ Deactivating the Talk button with the mouse or

¢ Pressing the Escape key on your keyboard

e Clicking the Listen button with the mouse

If Talk Mode has been set to Group or All Active, the Listen button is disabled and turns blue

Talk Mode
The Talk Mode setting determines which intercom(s) will hear audio sent from TalkMaster™.

12
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Talk Mode
) Selected
O Group
O all Active

Play File

Chime

Selected - refers to the intercom currently highlighted in blue in the Intercom View / Custom
View list. This option allows 2-way communication with a single Intercom.

Group - refers to any Intercom or Paging Group that has an X in the Grp column of the

Intercom View / Custom View list. This option allows 1-way communication with any number
of Intercoms.

All Active - refers to all currently connected Intercoms in the Intercom View / Custom View
list. This option allows 1-way communication with all Intercoms.

Switching from Selected to either Group or All Active will automatically disables the Listen
function and changes the Talk button to a blue Page button.

: _ ) Group
Audio Archive ) Al Active
Iv Capture

Play File
Lister mode =
O Chime
= - 1
-
— -

When using Selected mode, audio is sent to the Intercom using a single TCP/IP stream. This

allows you to communicate with an Intercom located anywhere that you can connect to
through TCP/IP.

When using Group or All Active modes, audio is sent to the Intercoms using a single UDP
Broadcast stream. Since UDP Broadcasts are filtered by many routers, the Group and All
Active options may only work on the current segment of a Local Area Network. Please refer
to the TalkMaster installation CD for instructions on installing the UBAM™ software if you need
to broadcast on multiple network segments.

Pressing the Talk/Page, Chime, or Play File button will send audio to the intercom(s) you
have indicated.

Play File - Brings up the Paging Messages dialog. Play File changes to Stop File while a file
is being set one or more intercoms. You can terminate the active file by clicking Stop File

To play a .wav file on the Intercom(s), audio files must be encoded in either 8khz 8-bit PCM or
16-bit uLaw format. Commercial or free software is available to create these formats.

Chime - plays the page.wav file from the iSupport subdirectory located under the

TalkMaster™-ii3 program directory. Page.wav is a recording of four successive beeps that you
can play to get someone’s attention at an intercom(s).

13
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Talk/Page will turn on the PC’s microphone to send the audio to the Intercom(s). Please refer
to Talk button for details.

Talk / Page button

The Talk/Page button turns on the PC’s microphone and allows you to speak to the intercom
highlighted in blue in the Intercom View / Custom View list.

By default, the state of the Talk button is toggled by:
¢ Single clicking the Talk button with the mouse or
e Tapping the Space Bar

By checking the Hold down Talk button while speaking (PTT) box in menu Admin -
Preferences - Options tab , the Talk button can be activated by:

e Clicking and holding the mouse on the Talk button or
e Pressing and holding the Space Bar

If Talk Mode is set to Group or All Active, the Talk button turns blue and changes to a Page
button. Intercoms or Paging Groups must have an X in the Grp column to be sent a Page.

Paging Messages

Clicking the Play File button brings up the Paging Messages dialog. The buttons on this
screen are defined via the Paging Setup dialog.

# Paging Messages

T  LuchTime TomadoWaming |

Schools Out | | ‘

Tl oK Help |

14
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When a button is pressed, the associated file is played to the Intercom(s) specified by the Talk
Mode.

When a Paging button is pressed, the Stop Message button becomes active till the file has
completed. Pressing the Stop Message button terminates file being played.

If the OK button is pressed you are returned to the main TalkMaster screen. If a file is still

being played, the Play File button changes to Play Stop allowing you to terminate the
recording.

Please note that you cannot respond to any calls until the paging message has completed.
If the Find File button is available, you can select a file of your choosing to play.

System Events

The System Events window tracks activities from TalkMaster™. Information in this window
can be used by Digital Acoustics Technical Support for diagnosing support issues.

System Events
ready . 2 intercomsz online. Mo calls waiting

Audio Archive

A checkmark in the Audio Archive Capture box indicates that TalkMaster is archiving
speaker and microphone audio for playback at a later time. This function is controlled through
the menu Admin - Capture Audio Archive. If TalkMaster's Admin menu has been enabled,

you can also check/uncheck this box. Please refer to Capture Audio Archive for more
information.

Audio Archive
=

To play back archived audio, use the menu Admin - Play Archive Audio.

15







Using Call Announcement

Call Announcement

Call Announcement causes an audible and/or visual alert to be issued to the TalkMaster™
operator when the Call or PTT button on an intercom is pressed.

Selecting menu Admin > Preferences and checking Activate Call Announcement in the
Options tab turns this option on. If this option is selected, Listen Mode is set to Automatic
and is grayed out.

If the TalkMaster screen is minimized and the button on the Intercom is pressed, the Incoming
Call dialog will be displayed.
If multiple Intercoms call in, they will be queued in a "first in - first out" basis.

If an Intercom user calls in when no calls are active, the Answer Later button appears on the
tool bar. To answer the call immediately, the operator can activate either the Talk or Listen
buttons. Answering the call removes the Answer Later button. Pressing the Answer Later
button will acknowledge the Audible and Visual notifications and send a message (i.e. "one
moment please") to the Intercom. This allows the TalkMaster operator to complete another
task before answering the incoming call.

Example of using Call Announcement:

Please note that the following example uses the option of holding down the Space Bar to
activate the Talk button and releasing the Space Bar to activate the Listen button as well as
pressing the Escape key to end the call. Please see menu Admin - Preferences - Options tab
for alternate methods of controlling the Talk and Listen buttons.

o A user presses and releases the "Call" or PTT button on the Intercom
¢ A short message (i.e. "your call is being connected") is returned to the Intercom.

e The Title Bar and the Icon in the Task Bar begin to flash and/or the audible notification is
played at the TalkMaster console up to 4 times or until the operator engages the Talk,
Listen or Answer Later button.

¢ An entry for the intercom is added to the Call Queue

e The Intercom is selected (highlighted with a blue background) in the Intercom View / Custom
View

o The TalkMaster operator responds by holding down the Space Bar on the keyboard and
speaking into the microphone.

e When the TalkMaster operator releases the Space Bar, the Talk button is turned off and the
Listen button is turned on. This allows the Intercom user to operate "Hands Free"

e Each time the TalkMaster operator holds down the Space Bar, the Talk button is activated.
When the Space Bar is released, the Talk button is turned off and the Listen button is
engaged.

¢ To end the conversation with an Intercom, the TalkMaster operator presses the Escape key
on the keyboard while the Listen button is active.

e The Intercom is de-selected in the Intercom View / Custom View
e The entry is deleted from the Calls Waiting list

o If another entry is in the Calls Waiting list, it is automatically selected so the TalkMaster
operator can start the next call by pressing the Space Bar




Using Call Announcement

An important benefit of using Call Announcement is that any other intercom is prevented from
interrupting your "conversation"” because the Talk or Listen button is always active.
TalkMaster will not interrupt a call if there is already one in progress. Any other intercom that
tries to contact TalkMaster will be placed in the Calls Waiting list.

Incoming Call

The Incoming Call dialog appears when the Activate Call Announcement option has been
selected in menu Admin - Preferences - Options tab and the TalkMaster screen has been
minimized.

#' TalkMaster LE - Incoming Call

Answer Now Answer Later

Clicking the Answer Now button with the mouse or pressing the Enter or Space Bar key
brings up the main TalkMaster window.

Clicking the Answer Later button with the mouse sends a message (i.e. "one moment
please") message to the Intercom, closes the dialog and turns off the Visual and Audible
Alerts. This action allows the TalkMaster operator to complete another task before answering
the incoming call. If the call is not answered within 30 seconds, the Incoming Call dialog will
open again and the Visual and Audible alerts will be triggered. Clicking the TalkMaster Icon in
the Windows Task Bar or System Tray restores the TalkMaster screen with the Intercom
selected in the Intercom View / Custom View.
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Preferences

Preferences are used to specify various settings for TalkMaster™. This is accessed from the
menu Admin - Preferences.

The Options tab is used to customize the way TalkMaster works.

The Multimedia tab is used to select the speaker and microphone devices
The Volume tab is used to change the Volume on an Intercom

The Legacy tab is retained for compatibility with older Intercoms

Preferences - Options tab
The Options tab sets options that affect the behavior of all intercoms.

'™ Preferences @

Options lMuItimedia] ‘v’nlume] Legacy]

Application Options &
Fing Intereal Startup Audio

* Beep
0 secands
l_ " Speech

[v Usze beep tones at start and end of incoming callz
[ Hide when minimized

[v Haold dowvn T alk buthas while speaking [PTT)

v Activate Call Announcerment

Call &nnouncement Matification
Iv “isual notification

¥ Audble Notification  |02" Bel =]
[v Fecord Audioin Call \Waiting Quele
Hide View Tab
v ntercom Wiews [ Custom Yiew
Heln | 0K |

Ping Interval - sets how often TalkMaster™ will send a Ping command to the intercoms to
verify the connection

Startup Audio - Determines if a beep or a wav file is played when the Intercom connects to
TalkMaster™. If you select Speech, you can select from a variety of .wav files or record your
own.

Use beep tones at start and end of incoming calls - When this option is checked a beep is
inserted at the beginning and end of each audio segment.

Hide when minimized - When this option is checked TalkMaster is minimized to the Windows

System Tray when either the - or X in the upper right hand corner of the screen

are pressed.
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To close TalkMaster, use menu File - Exit or right click on the TalkMaster ICON is the
system tray and select Close Program

If you check this box, it is recommended that you also check Activate Call Announcement so
that the Incoming Call dialog is displayed when TalkMaster is minimized. Otherwise,
TalkMaster can only be recalled by double clicking the TalkMaster ICON in the system tray.

Hold down Talk button while speaking (PTT) - When this option is checked, the Talk button
can be activated by pressing and holding down the Space Bar or by clicking on the Talk button
and holding the mouse button down.

If this option is not checked, the Talk button can be activated/deactivated by single clicking the
Talk button or tapping the Space Bar on your computer keyboard.

Activate Call Announcement - When this option is checked, the button on the Intercom is
treated as a Call button. After pressing and releasing the Intercom’s Call button, the message
"your call is being connected" is played at the Intercom. The Call Announcement
Notifications will then be triggered in TalkMaster. Please see Call Announcement for more
details.

Call Announcement Notification - These notifications alert the TalkMaster operator to an
incoming call. The alerts will be triggered up to four times at 5 second intervals until the
incoming call is answered. If the TalkMaster operator is already on a call, the alerts will not be
triggered.

Visual Notification - Checking this box causes the TalkMaster title bar and task bar icon to
flash.

Audible Notification - Checking this box causes the selected audio file to be played at the
TalkMaster console. Select the Door Bell or the Custom option from the list. If you select
Custom, you can record over the custom_announcement.wav file in the iSupport subdirectory
of the TalkMaster program directory. If you record a new wave file, it should only be one or
two seconds long since the wav file will not be interrupted once it starts playing! See Changing
Recordings for more information.

Record Audio in Call Waiting Queue - If a call is added to the Calls Waiting queue, checking
this box allows audio captured during the Intercom’s initial button press to be made available
for playback from the Calls Waiting Queue.

Hide View Tab - Checking either the Intercom View or Custom View allows you to present a
single view to the TalkMaster Operator.

Preferences - Multimedia tab

The Multimedia tab is used to select the multimedia device to be used for the speaker and
microphone.

When the Microphone uLaw box is checked, microphone audio will be sent in uLaw format
instead of PCM format. Audio sent in uLaw will be clearer and will have less noise than PCM
audio. If your Multimedia card does not support uLaw, this option will be grayed out.
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.....................................

W ave output device

SoundMai Digital Audio [ztereo) j

W ave input device

| SoundMai Digital Audio [ztereo) j

[+ Microphone uLaw

Help | 0K |

Preferences - Volume tab
The Volume tab is used to make adjustments to individual Intercoms.

Dptiuns] tultimedia EVDWI’HEH Legau:y]

_=| Selected
| Intercom

Audio Yolume

I
Softer 5 Louder

Friendly Name [&lias) |

Help | 0K |

Selected Intercom - You can use the up and down arrows to select an Intercom from the list
of intercom connected to TalkMaster™.
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Audio Volume - sets the audio volume on the selected Intercom. This can be overridden at

the Intercom by using the Volume Up and Volume Down buttons.
Friendly Name (Alias) - Displays the selected Intercom’s Name.

Preferences - Legacy tab

The Legacy tab is used to change configuration settings on individual Intercoms. It is retained
for compatibility with legacy intercoms as these options are now included in the Configure
Intercoms menu item. This will only re-program Intercoms with an ICOM

version of 1.8.1 or earlier.

Dptiuns] Multimedia] Yolume Legacy

These settings are only for Intercoms with an
Intercom O3 Yersion of 1.8.1 or eatlier

_=| Selected |IPaddress 192.168.264.113
| Intercom  Intercom D 03031

05 +1.9574%-0.0-1.0

GPIO 4 Mode
{*+ Factary Default " Relay output
" Logic input " Talk/Listen indicate

[ Remaote listen dizable [ Beep dizable
[ Default to lizten

Help i 0K

Selected Intercom - You can use the up and down arrows to select an Intercom from the list

of intercoms connected to TalkMaster™.

Please refer to the Advanced Configuration section of the Intercom configuration tool for the

definition of these options.

Paging Groups

The Paging Groups screen is accessed via the menu Admin - Maintain Paging Groups. It
allows you to create groups of Intercoms that you want to send audio to at the same time.

Paging Groups are normally created for units that only have speaker output.
Paging Groups are listed first in the Custom View tab.
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m. Maintain Paging Groups @

Select a group |Indoor Speakers j
Mew ‘ Save ‘ Delete ‘
Group Mame  [indoor Speakers
Location Mame I IP Address I Location N ame I IP Address
Parking Lot - West Speaker  192.168.254.113 Office Overhead Speaker 192168, 254,164
Back Daoar Intercom 192.168.254.111 Lunch Room Overhead Speaker  192.168.254.163
Font Droor Inkercom 192.168.254.108
Parking Lot - East Speaker 192.168.254.162
Reset
Dore Cancel Help

¢ To create a new Paging Group - press the New button. "New Group" appears in the Group
Name field. To specify a custom name, type over "New Group". Select an intercom from the
left column and click the >> button to add it to your new group in the right hand column.
Click Save when done.

¢ To change an existing Paging Group - use the "Select a group" drop down list to pick a
group. Change the name by typing over it or use the >> and << buttons to add or remove
Intercoms. Click Save when done.

o Delete - pick the Paging Group from the Select a group drop down list. Click the Delete
button to permanently remove it

¢ To exit this screen - press Done
e To cancel changes - press the Cancel button instead of the Save button

Paging Setup

The Paging Setup screen is accessed via the menu Admin - Maintain Paging Messages.
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#. Paging Setup

Select Button Color

’T J ! Undo | Reset |

EETTE [ > | el G | [Towdwanng i
[Schools Out ﬂ | ﬂ ! E J
| w| | | &y o]
| w»| w0 w| ]
| w| | | &y o]
| w| | | &y o]

[ Allow Usars to Select Files oK | -~ | Help |

Up to 18 buttons can be associated with pre-recorded wav files for use in the Paging
Messages dialog. Buttons can have one of four colors.

o Select a button "slot" and type in the text to be displayed on the button.

e Assign a color to the button, by clicking on one of the four choices.
Select Button Color

KR - Al

e Click the Folder Icon E and select the wav file to be associated with the button. A folder

Icon with a green background indicates that a file has been associated with this button.

Please note: the file must be in 8kHz 8-bit PCM or 16-bit uLaw or it will not play on the
Intercom. Commercial or free software is available to create these formats.

Click the Play button ﬂ to verify the audio recording.

Checking the "Allow Users to Select Files" places a "Find File" button on the paging
dialog, allowing the user to select a file of their own choosing.

Clicking the Undo button, clears any changes that have been made in this session

Clicking the Reset button clears all buttons

Clicking the Cancel button closes the dialog without saving changes

Click the OK button save any changes and closes the dialog

Capture Audio Archive

This option will capture all audio data to the file system. It is activated from the menu Admin >

Capture Audio Archive or by checking the box on the main display.

Audio Archive
[ Capture

Each time microphone or speaker output is produced, a separate file is created using the
following naming convention

XXX-YYYYYYYYYYYY-HHMMSS.wav where:
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o XXX - IN for speaker audio, OUT for microphone audio

e YYYYYYYYYYYY - the twelve digit Ethernet MAC address of the intercom that was
communicated with.

¢ HHMMSS - Hours, minutes and seconds of the day in 24 hour format

e .wav - standard PCM or uLaw wave file format. Audi from an Intercom will always be PCM.
Microphone audio can be either PCM or uLaw depending on the options selected on the
Multimedia tab of the Preferences dialog.

The files are stored under the TalkMaster-ii3/iArchive directory. Each day an additional sub-
directory is created so all audio archives for that day are stored in a single directory. The
directory name is formatted as YYYYMMDD where YYYY is the year, MM is the month and DD
is the Day of the month.

It is the user’s responsibility for backing up and managing the size of the
iArchive subdirectory!

The Play Audio Archive function can be used to easily find and play audio files for any date
and time.

Play Audio Archive

The Play Audio Archive function allows you to select and play a series of audio clips that have
been archived. It can be accessed from the menu Admin - Play Audio Archive.

#' Archive Audio

June 2004 |June ﬂ |2M4ﬂ

Mon Tue Wed Thu Fri Sat Sun
1 2 3 4 g g
7 g g 10 11 12 13
14 15 16 17 18 9 20
21 22 23 24 25 26 27
28 29 30

HEHBEEEEREEBEEEEEEEEEEEEEEE

1

Friendly Mame Clip Type  Intercom
Intercom [0 075713, Start Time 75713
Taotal Time 000253 Clip Time  00:00:08
Time Left 00:02:53

< Flay ‘ ‘ >

Use the drop down boxes to select the month and year and then select a day. Any audio
streams which have been recorded are shown with vertical lines above the hour of the day.

The green lines represent the start of microphone audio and the red lines represent the start of
speaker audio. The blue bar indicates the current position for the Play button.
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Click on a vertical bar and click Play. The audio will be played until you click Stop or the end of
the day is reached. As the audio is played, the display changes to indicate which intercom the
audio came from or was sent to.

If you want to skip backwards or forward between audio clips, use the << or >> keys.

Managed Intercoms

TalkMaster™ allows you to create a list of managed Intercoms so you can always determine
whether they are online or offline. When you start TalkMaster, all managed Intercoms are

listed with a red ICON ® . As each Intercom connects, the ICON turns green @

To add an Intercom to TalkMaster's managed list, check the List when offline box in the
Intercom Configuration Tool. This box is automatically checked when the Assign this PC
address as client’s server box is checked. The Intercom’s unique ICOM ID is used to track
the Intercom.

You can also configure an intercom by right clicking on it in the Intercom View / Custom View
and selecting the List when Offline option.

If you need to remove an Intercom from the Managed Intercom list, you can right click on it in
the Intercom View / Custom View and select the Do NOT list when Offline option.

You must be in Admin mode to activate the List when Offline / Do NOT list when Offline
right click option.

If an Intercom is offline, its ICON will turn red.

@ | ] |F'arking Lat - Wwest Speaker Digconnected

If one or more Intercoms within a Paging Group are offline, the Paging Group’s ICON will turn
yellow. Right clicking on the Paging Group will show all online and offline Intercoms for that
group.

& | [ |Dutu:|n:u:ur8peakers | | |
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Forward Intercoms

The Forward Intercoms function allows one or more TalkMaster™ consoles to temporarily
assign all of their intercoms to another PC running TalkMaster. This option can be accessed

from menu Console - Forward Intercoms or from Tool Bar ICON

s Forward Intercoms to Alternate Con... @

Location Marne | I | Count
Friendly Mame Mat Set 102800 1]
ECM - Client 102730 0

s

. Forward i | 1921682543  : |3000

Once you forward the intercoms, the Forward Intercom window will stay open and the
Forward button will change to Return. The Pressing the Return button will send a message
to the alternate console indicating that the intercoms will be retrieved. If the alternate console
does not respond within 15 seconds, you will be asked if you want to retrieve the intercoms
anyway.

If you need to shut down the TalkMaster™ console while this dialog is open, the Intercoms will
stay forwarded to the Alternate Console. To return the Intercoms to this console, you will need
to use the menu Console > Retrieve when you open up TalkMaster the next time.

Retrieve Intercoms

The Retrieve Intercoms function will retrieve Intercoms that have been forwarded with the
Forward Intercoms or that have been automatically forwarded via the Fail Forward function.
Only those Intercoms that have their default Server IP set to this TalkMaster™ console will be

returned to this console. This option can be accessed from menu Console > Forward
=

=

Intercoms or from Tool Bar ICON =

Unattended Console

Setting the TalkMaster™ software to Unattended mode makes the console temporarily
unavailable. If the PTT button is pushed on an intercom, a message indicating that says "We
are unavailable to take your call at this time" will be sent. This message can be changed by
re-recording the unavailable.wav file in the iSupport subdirectory of the TalkMaster-ii3
directory. See Changing Recordings for details.

27




TalkMaster Console Forwarding

Console Currently Unattended

IInattended Mode iz Enabled

Prezs "Cancel" to return Conzale to normal
operation status.
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File Menu

Wiew
Exit |
The File menu has one option:

Exit - will end the TalkMaster™ server session.

View Menu

\UETE Tools Console
Event log
Screen position »

The View menu has three options:

Event Log - allows you to display the TalkMaster™ event log and save it as a text file.
Screen Position - has two options:

¢ Save current view saves the current window size

¢ Reset to default - sets it back to the size that the product originally shipped with.

Tools Menu

Cnnsule Admin  Help

Mic and Speaker Levels
Common IF ports

v Record program events to file
Reset All Connections |

Mic and Speaker Levels - adjusts audio levels sent to and received from the intercoms. You
can also change the source used for the Talk/Page button from the microphone to
Internet/Line In which allows you to play other sources of audio through the intercoms.

4 TalkMaster Audio Control 2K

Advanced

Adust Levelz

|
Al

f* Microphone audio sent to inkercoms
(" Internet or 'Line In' audio zet to intercoms
(" Audio from intercoms [heard an thig PC)

=

Microphone Lewvel to Intercoms

[ Mute

(* |Jze Microphone 0K
" lze Internet/Line |
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Adjust Levels

¢ Microphone audio sent to intercoms - with the radio button selected, adjusting the slider
affects the Windows Microphone Recording volume

¢ Internet or ‘Line In’ audio set to intercom - no adjustment allowed

¢ Audio from Intercoms (heard on this PC) - with this radio button selected, two options are
presented

o Master Volume - adjusts the Windows Master volume control
¢ Volume from intercoms - adjusts the Windows .wav file volume

Common IP Ports - is a list of commonly used port numbers. You may reference this if you
need to change the standard ports used by TalkMaster™.

Record program events to file - should only be checked if directed by Digital Acoustics
Technical Support. Leaving this option checked for an extended period of time can cause
TalkMaster™ performance to be affected.

Reset All Connections - will cause TalkMaster to drop all current IP connections to active
intercoms and force them to reconnect to TalkMaster™.

Console Menu

orward Intercoms

Fetrieve Intercoms

Linattended Console

Forward Intercoms - brings up a dialog box allowing you to temporarily forward all of the
active intercoms to another PC running TalkMaster™. Refer to Forward Intercoms for
complete instructions.

Retrieve Intercoms - will retrieve any intercoms from other PC’s running TalkMaster that have
this PC’s IP address assigned as their primary server to connect to. This can be used to
retrieve intercoms that have been forwarded via the Forward command or by the Intercom’s
Fail Forward configuration to another console

Unattended Console - allows you to temporarily suspend the consoles operation. Any
intercom that tries to contact the console is notified that no one is available to take their call. A
dialog pops up reminding you that this mode has been set. Clicking the Cancel button returns
the console to normal operation.

This setting is saved between TalkMaster sessions.

Admin Menu
The Admin Menu allows you to configure TalkMaster™ for your environment.

el

Enable Admin

To activate all of the options on the Admin Menu, click Enable Admin. You will be asked to
enter your Admin password (default is admin). The full Admin Menu will then be activated.
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m Help

Set Administrator Password
Preferences

Maintain Faging Groups r
{  Maintain Paging Messages ;

Configure Intercoms

| Play Audio Archives 4
| v Capture Audio Archives :
Intercom OS5 Recovery
Check for new versions online
Disable Admin
Set Administrator Password - brings up the Change Administrator Password dialog. You
must enter your current Administrator password before entering a new one.

Preferences - opens up the Preferences dialog.

Maintain Paging Groups - brings up the Paging Groups dialog. This is used to group
Intercoms together for paging purposes

Maintain Paging Messages - brings up the Paging Setup dialog. This is used to setup the
Paging Messages dialog with pre-recorded messages.

Configure Intercoms - brings up the Intercom Configuration Tool. This is used to setup the
intercoms with IP addresses, other configuration information and to load new firmware.

Capture Audio Archives - toggles on and off the capture of microphone and speaker audio.

Play Audio Archives - opens up a dialog that allows you to select audio archives for playback
by date and time.

Intercom OS Recovery - is used to recover the ICOM firmware if the "Reload ICOM
Firmware" message appears in the Notes column in the Intercom View.

Check for new versions online - is used to check for and perform online updates to the
TalkMaster software from the Internet.

Disable Admin - hides all Admin menu options except for Enable Admin.

Help Menu

Help on using TalkMaster®
Online Documentation ‘

Digital Acoustics Web Site
About |

Help on using TalkMaster™ - Opens up Help
Online Documentation - Directs you to online documents on the Digital Acoustics Web site
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Digital Acoustics Website - Directs you to the Homepage for ii3 Intercoms
About - Displays the current version information about TalkMaster
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Configure Intercoms

When Intercoms are shipped from Digital Acoustics, they do not have IP address information
configured. To configure them, you must connect them to your network, install TalkMaster™
and select the menu Admin - Configure Intercoms.

The Intercom Configuration Tool will immediately search for all Digital Acoustics intercoms
connected to your current network segment. You must match the lcom ID displayed on the
TalkMaster screen to the ID# printed on the back of the intercom and then configure the
Intercom’s IP address information and the IP address of the server it will connect to.

If you have intercoms located in a different network segment, you may not find them since
many routers filter out UDP Broadcasts. You can either install these intercoms on the current
network segment or you can install a copy of TalkMaster in the other network segment to
configure your intercoms. You may also refer to the TalkMaster installation CD for instructions
on installing the UBAM™ software which will allow you to configure units across different
networks.

A network segment is determined by looking at the subnet mask and the corresponding bits in
the IP Address. For example, on IP Address 192.168.2.175 Subnet 255.255.255.0, the
network segment is 192.168.2, and on IP Address 126.10.11.12 Subnet 255.255.0.0, the
network segment is 126.10.

To configure Intercoms to connect to TalkMaster™, see Intercom Configuration - TalkMaster
Clients.

To configure two Intercoms to communicate with each other in Direct Mode, see Intercom
Configuration - Direct Mode.

Advanced Configuration

When the Advanced Configuration option is checked in the Intercom Configuration Tool View
Menu, you can specify addition options for an ii3 Intercom.

If these options are grayed out, you have an intercom with legacy firmware. You can configure
intercoms with legacy firmware from the main TalkMaster™ screen using the menu Admin >
Preferences and selecting the Legacy tab. To update the firmware, see Updating Firmware.

AEiETEES SE TS GPIO 4 Control Made

| % Factoy Defaul O Remate Listen Disable

~ I:l O Default ta Listen [Direct Made)
[ Mo EBeep Tone After PTT Feleazed

Fail Forward IP1 [ 0000 |
Fail Faraard [P 2 | 0000 |:
|

i Logic [nput
Fail Fonward IP 3 | 0.0.0.0 | ¢ Activate On [ O [ Display in Custom View Tab
™ Activate On PTT O call Button

Fail Forward IP 1,2,3 allow you to specify up to three IP addresses of alternate TalkMaster
consoles that this Intercom will attempt to connect to if it's current TalkMaster console
becomes unavailable. If an Intercom has failed forward to an alternate IP and it's default
TalkMaster console is restarted, the default TalkMaster console can reacquire the intercom by
using the menu Console > Retrieve Intercoms.

GPIO 4 Mode allows you to specify how General Purpose /O (GPIO) port 4 is used. On
Intercom models with an integrated relay (dry contact), GPIO 4 is used to activate the relay.

The normal state for GPIO 4 is logic high (+5 volts). When activated, it changes to logic low (0
Volts).
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o Factory Default - on EDW/EDB units, causes GPIO 4 to control the Monitor button. On all
other units, this setting has no effect.

e Door / Relay Control - for use on models that have an integrated relay. The Door/Gate
button will become visible in the Intercom View / Custom View. Pressing the Door/Gate
button will engaged the relay for the number of seconds specified (defaults to 5 seconds)

¢ Logic Input - used with custom developed applications to monitor other equipment.

o Activate On MIC / Speaker - Selecting this option turns on GPIO 4 (or the onboard Relay if
present) when ever the Intercom’s Microphone and/or Speaker are activated. When both
Mic and Speaker are checked, the Intercom will wait for 1 second of inactivity before turning
off GPIO 4. Use of the Mic option requires the Intercom’s OS Version to be 1.9.5.74Y or
higher

o Activate on PTT - activates GP1O4 (or the onboard Relay if present) when the Intercom’s
button is pushed

Remote Listen Disable - disables the ability to remotely turn on the Intercoms Microphone.
With this option set, the Intercom Operator must press the PTT button on the Intercom in order
for the other end to listen to the Intercom.

Default to Listen (Direct Mode) - is only available if option Set as Server Intercom is
enabled. Enables the Server Intercom intercom in Direct Mode to automatically turn on the
remote Intercom’s Microphone when the Intercoms connect.

No Beep Tone After PTT Released - turns off the soft beep that is played on the intercom
after the PTT button is released. This option is only valid for Direct Mode and must be set on
both the Client and Server to work properly.

Display in Custom View Tab - will force the Intercom to appear in the Custom View tab, even
if it is included within a Paging Group.

Call Button - Changes the Intercoms PTT button to a Call button. Prevents audio from being
transmitted when the button is pressed. See PTT button vs Call button topic. This option is
not valid in Direct Mode or when the Remote Listen Disable option has been selected

PTT Button vs Call Button Feature

By default, when the PTT button on an Intercom is pressed, the Intercom’s microphone is
turned on and the audio is transmitted to TalkMaster™. TalkMaster receives the audio,
records it, places an entry in the Calls Waiting Queue and sends the "Your call is being
connected" message to the intercom. If desired, the TalkMaster operator can play the audio
back by double-clicking the entry in the Calls Waiting Queue. When the TalkMaster operator
activates the Listen button, the Intercom’s microphone automatically switches on so the
Intercom user can operate in Hands Free mode.

When the Call Button feature is enabled for an intercom, the PTT button’s function is changed
to a Call button. When the Call button is pressed, a short signal is transmitted to TalkMaster.
TalkMaster receives the signal, places an entry in the Calls Waiting Queue and sends a signal
to play a two tone beep on the Intercom. No audio is captured in the Calls Waiting Queue
using this option. When the TalkMaster operator activates the Listen button, the Intercom’s
microphone automatically switches on so the Intercom user can operate in Hands Free mode.
Intercoms in Call Button mode play a two-tone beep whenever they connect to TalkMaster.

The Call Button feature has been implemented for customers who are not able to support
multiple concurrent audio connections due to low bandwidth TCP/IP connections. It can also
be used in environments where hundreds of intercoms could be activated simultaneously
causing a potential overload of the network and server.
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Selecting this option disables a potentially important feature in so its use should be based on
the factors considered to be of most importance in the environment that it is installed in.

Intercom Configuration - TalkMaster Clients

Configuring intercoms for use with TalkMaster (Point to Multi-Point)

This procedure configures Intercoms to connect to the IP address of the PC running
TalkMaster™. This connection can be on a LAN, WAN or across the Internet.

To configure two intercoms to connect to each other, please see Intercom Configuration -
Direct Mode.

From the main TalkMaster™ screen, select the menu Admin - Configure Intercoms. The
system will scan the local network segment using a UDP Broadcast to find all ii3 Intercoms.
New Intercoms will show up with IP addresses of zero. The lcom ID displayed on the
screen will match the ID# printed on the back of the Intercom.

Selected Intercom Setting

Location Mame | Icom ID | IP Address | Details -~
# Clent ¢ § e c

W 0310A1 0.0.0.0 No IP addr = it
$Emergenc:ﬁCaIIE-Jx... 030C3E 192.168.254.1.. Client [¥] Assign IP autormatically with DHCP
;EEmergenc;.'CaIIch... 030C0D 192.168.254.1... Client
== = SR ; IP Address | |
i Entry-East 105709  192.168.254.1... Client DHCF
s Entry-west 115939 192.168.254.1.. Client DHCF Subinet Mask | |
i@ Fire Exit#1 105560  192.168.254.1.. Client DHCF - Gateway | |
F™ Fire Exit #2 030F51 192.168.254.1.. Client DHCH DS | |
| o & -
ugn Fover-East 102774 192.168.254.1.. ClientDHCF
f Foyer-West 102828  192.168.254.1.. Client DHCF Pt [ 0]
s Gats #1 030C27  192.168.254.1.. Client Location Mame: [Fire Exit #2 |
fge Cate #2 030C08  192.168.254.1.. Client
i Loading Dock #1 030C15 192.168.254.1.. Client [ Aasign this PC address as client's server
TE 1l Aadina Dank #0 n 2 180 7R i i
P r— S @ Server [P [ 192.168.254.55 |:[ 3000 |
This PCis: MPCO03 : [ List when offiine
IP | Port[ 3000 ] @ Exit_| Cancel Apply |

Search

FRahced g GPIO 4 Control Mode

[ Femate Listen Dizable

; f*" Factory Default
Fail F dIF1 0000 1 0
af e | | | | " Door / Relay Control I:l O
FalFowardiP2 | 0000 | 0 | & [ Mo Beep Tone After PTT Releazed
Fal Foward P3 [ 0000 |:[ 0 | £ Activate On O #ic O O Display in Custom View Tab
" Bctivate On PTT [ Call Button

If you have intercoms located in a different network segment, you may not find them since
many routers filter out UDP Broadcasts. You can either configure these intercoms on the
current network segment prior to installing them on the desired network or you can install a
copy of TalkMaster in the other network segment to configure your intercoms. Refer to the
TalkMaster installation CD for instructions on installing the UBAM™ software to configure units
across different networks.
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Selected Intercom Setting
fo Client  Server i

Azzign IP automatically with DHCP
IP Address | |
Subnet Mazk | |
|

|

(3 ateway |

DNS |

Location Mame |Fire Ewit #2 |

[ &s=zign thiz PC address az client's server

Server IP | 192.168.254.55 |:| 3000 |

[ List when offline
E wit | Cancel | Apply |

For each intercom that you want to configure, click on it and then set the options as follows:
o Set as Client - Click this option

¢ Assign IP automatically with DHCP - This option determines how the Intercom’s IP
address is assigned. The Intercom IP address information can be assigned as a Static IP
address or can be dynamically assigned if your network has a DHCP server.

To use DHCP, check the box Assign IP automatically with DHCP.

Your system MUST have DHCP assignment capability if you choose to use this option. If
you are unsure do NOT use DHCP.

To assign a Static IP address, uncheck the box Assign IP automatically with DHCP and fill
in the IP Address, Subnet Mask and Gateway. The Port field does not have to be filled
out.

¢ Location Name - Assign a descriptive text name that uniquely identifies the Intercom. This
name will display in the main TalkMaster screen.

¢ Assign this PC address as client’s server - This option determines the TalkMaster IP
address that the Intercom will connect to.

Check Assign this PC address as the client’s server to have the Intercom connect to this
PC.

To specify a different TalkMaster console, uncheck the box and fill in the IP address and
Port.

o List when Offline - forces TalkMaster to remember this intercom and to list it on the
Intercom View and/or Custom View whether it is connected or not. This option can also be
toggled by right clicking on Intercoms in the Intercom View / Customer View tabs. The List
when Offline/Do NOT list when Offline option only appears when TalkMaster's Admin
menu has been enabled. Refer to Managed Intercoms for more information

Apply - This option will save your settings to the selected intercom. After applying changes to
an intercom, the unit will be reset and will be unavailable for 10-15 seconds

Cancel - This option cancels changes that have not been Applied
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Exit - This option closes the Intercom Configuration Tool screen and returns to the main
screen after you have completed configuring all intercoms.

This PC is: XXXXXXXX - This option allows you to change the default Port number
TalkMaster™ uses to listen for Intercom connections on. If you change this setting, it will be
reflected in the Assign this PC address as client’s server. Intercoms must be configured to
connect to TalkMaster on this port.

T[)@ FC is: MPCO03
IP| | Port| 2000 |

Search - will re-search the local area network for all Digital Acoustics’ ii3 Intercoms so you can
verify all of your changes. Please note, that if you Apply changes to an intercom, the unit will
be unavailable for 10 -15 seconds. If an intercom does not appear in the list, try searching a
second time.

e

Search

If you need to change other options on the intercoms, make sure that you check menu View >
Advanced. Refer to Advanced Configuration for details.

Intercom Configuration - Direct Mode

Configuring two intercoms in Client-Server mode (Direct Mode - No PC required)

This procedure configures two Intercoms to connect to each other. This connection can be on
a LAN, WAN or across the Internet.

To configure intercoms to connect to TalkMaster™, please see Intercom Configuration -
TalkMaster Clients.

From the main TalkMaster™ screen, select the menu Admin - Configure Intercoms. The
system will scan the local network segment using a UDP Broadcast to find all ii3 Intercoms.

New Intercoms will show up with IP addresses of zero. The lcom ID displayed on the
screen will match the ID# printed on the back of the Intercom.
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Ea

Location Mame lcom 1D | IF Address Details
W 031041 0.0.0.0 Mo IP addr
Z-EEmergenc_.-'CaIIE-jx... 030C3E  192.168.254.1.. Client
ZEEmergenc;.'CaIIE-Jx... 030C0D  192.168.2541.. Client
EEEntr;.-'-East 105709 182.168.2541.. Client DHCF
$Entr;.-‘-'.".‘est 115839 192.168.254.1... Client DHCF
3 Fire Exit#1 105560 192.168.254.1... Client DHCF=
030F51 192.168.254.1.. Client DHCH
$F-3;.-'er-East 102774 192.168.2541... Client DHCF
$F-Jg.-'er-'."';’est 102828 192.168.2541.. Client DHCF
f-ijate #1 030227  192.168.254.1.. Client
QEGate #2 030208 192168.2541.. Client
EEL-Jading Dock #1 030215 1982.168.2541.. Client
-“KI Andina Diaslk #7 nanmram 107 120 284 1 Tlinmt
< >

Selected Intercom Setting
(+ Client  Serer r

Azzign [P automatically with DHCF
IF Address |
Subret Maszk |

Gateway |
DHS |

L ozation Mame |Fire Exit #2 |

[ Assign this PC address as client's server

Server P | 192.168.254.565 || 3000 |

This PC is: MPCOO3
IP | Port| 3000 |

Advanced Settings

o

Search

GFIO 4 Control Mode

Fail Forward IP 1 | 0.0.0.0

Fail Forward IP 2 | 0.0.0.0

Fail Forward IP 3 | 0.0.0.0

| f* Factom Default

" Door / Relay Control I:I O

i Logic Input
| ™ Activate On [ O

" Activate On PTT

O List when offline
E it | Cancel | Apply |

[ Remate Listen Dizable

[ Mo Beep Tone After PTT Felsazed
O Display in Custom Yiew T ab
[ Call Button

If you have intercoms located in a different network segment, you may not find them since
many routers filter out UDP Broadcasts. You can either configure these intercoms on the
current network segment prior to installing them on the desired network or you can install a
copy of TalkMaster in the other network segment to configure your intercoms. You may also
refer to the TalkMaster installation CD for instructions on installing the UBAM™ software which
will allow you to configure units across different networks.

Determine which of the two intercoms will be the Server Intercom and which will be the

Client.

If the Server Intercom is an EDW/EDB:

¢ Quickly pressing the Monitor/Open button allows audio from the Client Intercom to be
monitored without the Client having to press a button. The Server Intercom can talk to the
client by pressing it's PTT button. The client operates in a fully "hands free" mode

¢ Pressing and holding the Monitor/Open button until a dual tone beep is heard will activate
the Door Relay on an EW2W or EWST Client Intercom. The relay will remain active for the
number of seconds specified in the Door / Relay Control option under GPIO 4 Mode

e The Server Intercom can talk over the Client
To set up the Server Intercom:
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Selected Intercom Setting

" Client f+ Server "
O
P Addiess | 19216525429 |
SubretMask | 256.256.25860 |
Gatewsy | 192166254254 |
DNS | |

Location Hame | |

O

O

E xit | Eanu:el| Apply |

Set as Server - Click this option

Assign IP automatically with DHCP - This option is automatically grayed out

IP Address - Enter the a fixed |IP address and the Port number of the Server Intercom.
Subnet Mask - Enter the Server’'s Subnet Mask
Gateway - Enter the Server's Gateway address. If no Gateway is available, enter 0.0.0.0

Port - Enter the Port number of the Server Intercom. You can change the default Port of
3000 as long as you specify the same port in the Client Intercom’s Server IP setting.

Location Name - This option is automatically grayed out

Assign this PC address as client’s server - This option is automatically grayed out

List when Offline - This option is automatically grayed out
Exit - This option closes the Intercom Configuration Tool screen

Cancel - cancels any changes made to the selected intercom before the Apply button is
pressed.

Apply - This option will save your settings to the selected intercom. After applying changes to
an intercom, the unit will be reset and will be unavailable for 10-15 seconds

To set up the Client:
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Selected Intercom Setting
(e Client  Server {

Azzign IP automatically with DHCFP
IF Address | |
Subnet Maszk, | |
|
|

G ateway |

DNS |

Location Mame |ZZ Client - 030613 |

[ &s=zign thiz PC address az client's server

Server P | 192.165.254.29 |:| 3005 |

[ List when offline
E wit | Cancel | Apply |

o Set as Client - Click this option

¢ Assign IP automatically with DHCP - The Intercom IP address information can be
assigned as a Static IP address or can be dynamically assigned if your network has a DHCP
server. To use DHCP, check the box Assign IP automatically with DHCP. Your system
MUST have DHCP assignment capability if you choose to use this option. If you are unsure
do NOT use DHCP. To assign an IP address, uncheck the box Assign IP automatically
with DHCP and fill in the IP Address, Subnet Mask and Gateway. You do not have to fill
out the Port.

¢ Location Name - the unique name you assign to this Intercom

¢ Assign this PC address as client’s server - This is automatically unchecked so you can
enter the IP address and Port number of the Server Intercom.

¢ List when Offline - This option does not apply to Direct Mode
Exit - This option closes the Intercom Configuration Tool screen

Cancel - cancels any changes made to the selected intercom before the Apply button is
pressed.

Apply - This option will save your settings to the selected intercom. After applying changes to
an intercom, the unit will be reset and will be unavailable for 10-15 seconds

Search - You can re-search for Intercoms to verify all of your changes. Please note, that if you
Apply changes to an intercom, the unit will be unavailable for 10 -15 seconds. If an Intercom
does not appear in the list, try searching a second time.

i

Search

The configured intercoms will look something like this:

Location Mame lcom 1D | IP Address Details -
i 030C3A 192168.254128 Client DHCP
ﬁglﬂain Office O30BED 192.168.254.15 Senver
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The Server will play a short beep and the Active and Link lights will turn solid on both
intercoms indicating that they have made a connection.

Updating Firmware

Updating firmware should only be done under the direction of Digital Acoustics Technical
Support. Improperly flashing Intercoms can render the units inoperable.

Intercoms must have minimum firmware levels of 1.9.5.66.1-xx.x-3.68.4 to use the following
features:

Console Forwarding
UDP Broadcast
Fail Forward IP addresses

Door Relay Activation time
Location Name Stored in Intercom

Intercoms shipped with TalkMaster™ include the most current firmware. To verify the firmware
level, right click on an intercom in the main TalkMaster screen and view the OS version. In the
following example, v1.9.5.66.8 is the ICOM version and 3.68.4 is the NIC version.

Send announcement 1o selected units
Activity and Connection Details *

Reset connection
Intercam ID# 1036E9
05 wersion: v1.9.5.66.5-0.0-3.68.4
If you would like to update firmware in your intercoms, please contact Digital Acoustics

Technical Support to verify upgradeability and to obtain the current firmware. Please have the
Intercom ID# and OS Version available for each intercom that you would like to upgrade.

In order to update NIC Firmware, see NIC Firmware Updating
In order to update ICOM Firmware, see ICOM Firmware Updating

NIC Firmware Updating

If you are going to perform a NIC firmware update, please consult with Digital Acoustics
Technical Support to verify upgradeability and to obtain the current firmware. Please have the
serial number and OS Version available for each intercom that you would like to upgrade.

In order to update the NIC firmware, you must configure the Intercom to connect to the copy of
TalkMaster™ that you will be doing the update from. Please refer to Intercom Configuration -
TalkMaster Clients.

It is strongly recommended that the update be done on a local area connection (LAN) instead
of on a wide area connection (WAN) due to the critical nature of firmware updating.

Use the menu Admin - Configure Intercoms to open the Intercom Configuration Tool.
Click on the Intercom you wish to update and select menu Action - NIC Firmware Upload.
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Confirmation for memory upgrade [

'E Update MIC operating system now?

[ ]
Selected intercom D [#102814]
with revision code dated Jun 15 2004,

Tes Mo

TalkMaster will connect to the Intercom and begin uploading the firmware. When the upload is
completed, a dialog box will be presented informing you that the action was successful. Once
you click OK, the screen will lock for 30 seconds while the firmware re-programming takes
place.

DO NOT TURN THE INTERCOM OFF WHILE THE FIRMWARE RE-
PROGRAMMING TAKES PLACE!

ICOM Firmware Updating

If you are going to perform an ICOM firmware update, please consult with Digital Acoustics
Technical Support to verify upgradeability and to obtain the current firmware. Please have the
serial number and OS Version available for each intercom that you would like to upgrade.

In order to update the ICOM firmware, you must configure the Intercom to connect to the copy
of TalkMaster™ that you will be doing the update from. Please refer to Intercom Configuration
- TalkMaster Clients.

It is strongly recommended that the update be done on a local area connection (LAN) instead
of on a wide area connection (WAN) due to the critical nature of firmware updating.

Use the menu Admin - Configure Intercoms to open the Intercom Configuration Tool.
Click on the Intercom you wish to update and select menu Action > ICOM Firmware Upload.

Confirmation for memory upgrade (8|

'E Update i3 flash operating systerm now?
[

Selected intercom ID: [#102314]

with revision code dated Jun 12 2004,

es Mo

TalkMaster will connect to the Intercom and begin uploading the firmware. When the upload is
completed, a dialog box will be presented informing you that the action was successful. Once
you click OK.

DO NOT TURN THE INTERCOM OFF WHILE THE FIRMWARE IS
UPLOADING!
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Intercom Configuration Tool Menu Options

Configuration File Menu

"-'ri 2w
Euit

Exit - exits the Intercom Configuration Tool

Configuration View Menu

@ action Help
1 ormmon Port Assignments

: v Advanced

Common Port Assignments - is a reference list of the common IP port settings

Advanced - makes the Advanced Settings section of the Intercom Configuration Tool
available. Please see Advanced Configuration for details. This setting is remembered
between TalkMaster™ sessions.

Configuration Action Menu

earch Boards

Apply settings

MIC Firrmware Upload
I2OM Firmware Upload

Search Boards - will search the current network segment for ii3 intercoms
Apply Settings - saves changes made to the current intercom

NIC Firmware Upload - updates a portion of the ii3 intercom firmware. This option will only
display if NIC firmware is present on your Hard Drive.

ICOM Firmware Upload - updates a portion of the ii3 intercom firmware. This option will only
display if ICOM Firmware is present on your Hard Drive.

Contact Digital Acoustics Technical Support if you have any questions on Firmware updates.

Configuration Help Menu

Eelp with Configuration Tool

Test DHCP connections |

Digital Acoustics Home Page :

Help with Configuration Tool - opens the Help window
Test DHCP connections - determines whether a DHCP server available on your network
Digital Acoustics Home Page - opens the default web browser to the ii3 intercom home page
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Troubleshooting
Intercom Configuration Tool cannot find Intercoms
o Verify that the ACTIVE or LD10 LED is on or flashing. If not, check the power connections.

o Verify that the LINK or LD9 LED is on. If not, verify the network cable between the Intercom
and the network switch.

¢ Verify that the Intercoms are on the same network segment as TalkMaster™. TalkMaster
uses a UDP Broadcast to search for Intercoms. Since most routers are configured to block
UDP Broadcasts, you will not be able to configure the Intercoms in other networks. Perform
the configuration in a single network, or install UBAM™ software from the TalkMaster
Installation CD.

o If you have multiple network cards in the TalkMaster PC, verify that intercoms are connected
to the card that TalkMaster has recognized. You can verify the IP address that TalkMaster is

using by looking in the Intercom Configuration Tool under "This PC is: XXXXXXXX":
TE@ PC i MPCO03
IP| | Port| 3000 |

o If the Intercoms are configured for DHCP and no DHCP server is available, try re-powering
the Intercom, wait 30 seconds, then try Searching 2 -3 times.

¢ If you cannot detect any intercoms using the Intercom Configuration Utility, connect the PC
directly to the ii3 intercom using a crossover cable. Verify that you have a valid IP address,
start TalkMaster and then try to Search for the Intercom again.

e You can also refer to the LED Indicator section in your hardware manual and review the
diagnostic information presented there.

Group, All Active functions do not work with Intercoms in other Networks

¢ If Intercoms are not in the same network as the TalkMaster, install the UBAM™ software off
of the TalkMaster Installation CD. UBAM™ is a software product that will send/receive
TalkMaster UDB Broadcast traffic between networks.

Configured Intercoms do not connect to TalkMaster

¢ Incorrect subnet or gateway address in the Intercom. Re-configure the Intercom using the
correct information.

¢ Incorrect Server IP address. Re-configure the Intercom using the correct information.

¢ Intercoms have been Forwarded or Fail Forwarded to a different IP Address. Use the
Retrieve button to reset all intercoms to connect back to their default IP address.

Resetting Intercom Confiquration

e To reset an ii3 Intercom’s configuration to factory defaults, unplug the power cord, press and

hold the Talk and Volume Up buttons, plug the power cord in, wait 2 seconds and release
the Talk and Volume Up buttons. A beep from the speaker indicates the intercom’s
configuration has been reset.

Changing Recordings

You can change the audio wav files played in TalkMaster™ or sent to the Intercoms. These
files are stored in the iSupport subdirectory of the TalkMaster software program directory.
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When the Call Announcement option is activated in the menu Admin - Preferences - Options
and an incoming call is received, a wav file is played at the TalkMaster console to announce
the incoming call. Two choices are available, either Doorbell or Custom. It is best to keep
the recording to 1 or 2 seconds. Once it starts playing, it will play until it is done and will be
repeated in 5 second intervals until a keyboard operation or mouse click occurs.

Wave File

When Played

Verbiage

custom_announcement.wav Call

Announcement
incoming call

Custom

Doorbell_announcement.wav Call

Announcement

incoming call

Chime

The wav files sent to the Intercoms must be encoded in either 8khz 8-bit PCM or 16-bit uLaw
format. Commercial or free software is available to create these formats.

Wave File When Played Verbiage
announce.wav Call Announcement Your call is being
greeting connected
announce_busy.wav Call Announcement - Please Hold
TalkMaster Answer Later
button pressed
End.wav End of call from TM Beep

i_activated_au.wav

Intercom Connection to
TalkMaster (Australian)

Intercom activated

i_activated_fr.wav

Intercom Connection to
TalkMaster(French)

Intercom activated

i_activated_po.wav

Intercom Connection to
TalkMaster (Portuguese)

Intercom activated

i_activated_uk.wav

Intercom Connection to
TalkMaster (U.K.)

Intercom activated

i_activated_us.wav

Intercom Connection to
TalkMaster (U.S.)

Intercom activated

in_page.wav

No longer used

Chime

page.wav

Chime button

Bell

please_wait.wav

TalkMaster is on another
call

Please hold while
your call is being
connected.
Someone will get
back to you as
soon as possible
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Start.wav

Start of call from
TalkMaster

Beep

unavailable.wav

Unattended mode is set in
TalkMaster

We are unavailable
to take your call at
this time
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Changing Recordings 45 Managed Intercoms 25
Client 35, 37 Manual Mode 11
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Configure Intercoms 29, 33 Monitor 33, 37
Connected 25 Mouse 19
Console Forwarding 27, 41 MuitiPoint 35
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Direct Mode 33, 37 New Intercoms 33, 35, 37
Disconnected 25 NIC Firmware Updating 41
Door/Gate button 33 o
E Online Documentation 31
Escape key 11, 12 Options 19, 33
Ethernet MAC 24 OS Version 41, 42
Event Log 29 P
F Paging 14, 23
Fail Forward IP 27, 33, 41 Paging Groups 22, 30
Firmware 41 Paging Messages 14, 23, 30
Flashing 41 Paging Setup 14, 23
Forward Intercoms 6, 27, 30 Password 30
G PCM 12, 20, 24, 45
Play Audio Archive 10, 25, 29
Gateway 35, 37
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S
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